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ESRI ArcGIS Pro Workflow for US Fish & Wildlife Service  

Wetland Restoration Engineering & Design 
By Scott Ralston, Wildlife Biologist USFWS Partners For Fish & Wildlife Program, Windom, MN. 
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Specific data examples for habitat work in MN but transferable concepts to other areas.   
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Introduction 

Purpose: This tutorial is a workflow for United States Fish & Wildlife Service staff to map wetlands or 
other habitat features, import survey data and design embankments or spillways or other cut/fill 
volumes in habitat restoration projects. Although specific to this workflow you may find many of the 
steps usefully to modify to your own specific needs. Scott has been working with GIS in wetland 
mapping & restoration work in the Prairie Pothole Region of North Dakota and Minnesota since about 
2001.  

Disclaimer: This tutorial is develop by Scott Ralston as an individual not as an official publication by the 
US government or USFWS agency. Developed as a guide for my own project workflow and willing to 
share to help others but this does not represent any official policy, training or regulation by the agency. 
All engineering and design should be done by trained professionals and users accept their own liability in 
project designs. Free to share this tutorial just reference or credit where appropriate.  

Introduction to ArcGIS Pro: This is a new platform for ESRI in GIS. The previous ArcGIS up to version 10x 
mainly used ArcMap as the functional mapping program. This tutorial and methods are an update from 
a previous version tutorial that was written for ArcMap so may refer to some similarities and 
differences. Major differences in ArcPro from 10x: 

- ArcPro is designed more around working with online data seamlessly with local data and 
integrating geodatabases into the map workflow. Users used to stand alone shapefiles still will 
have that function but should learn what a geodatabase is and how to use one for more 
functionality as many functions are automatically integrated into a database.  

- FWS users ArcPro can integrate FWS Portal data where ArcMap could only use AGOL and took 
extra steps to edit that.  

- ArcPro uses ribbon menus and popup panes vs fixed toolbars so some tool options you may not 
see all the time unless you are on a specific layer or task where that tool is available.  

- ArcPro has some enhanced performance and is better able to utilize your computers resources 
like 64 bit processing. It runs a bit smoother and faster.  

- ArcPro can support many maps and layouts in a single project similar to the old original ArcView 
3x. ArcMap was limited to 1 map and 1 layout in a project. 

- ArcPro combines all the sub-programs into 1 program. ArcGIS 10x had ArcMap for the mapping, 
ArcCatalog for file management, ArcScene for 3d mapping etc. where all this is merged inside of 
ArcPro.  

Setup & Customize Options & Create a Map: 

Before diving into project there are many options and preferences you should try to setup and 
customize to make the rest of your workflow much easier. Setting shortcuts and other options and 
making a template to simplify future maps on similar projects. 

1. FWS User Resources: USFWS users, all information or other resources for GIS needs can be 
found at the FWS Sharepoint page: https://doimspp.sharepoint.com/sites/fws-gis as well as on 
the Microsoft Teams FWS Geospatial Services team channel.  

2. Licensing: We will assume you have a license available for ArcPro. If you are a USFWS employee 
then you do. Other organizations consult your IT administrators. For FWS you must be 

https://doimspp.sharepoint.com/sites/fws-gis
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connected to your DOI network either at an office with intranet connection or if remote must be 
on the VPN.  

3. Checking out a license for offline: If you wish to work offline you have to first check out a 
license while you are still online and in the case of FWS must be on the intranet or VPN before 
you can work offline or off VPN.  

a. Open ArcPro 
b. On the Opening page hit Settings 
c. Choose Licensing from the left side 
d. Check the box that says Authorize ArcGIS pro to work 

offline. Can choose up to 90 days 

 

4. Portals: These are connections to online cloud data. FWS employees already have AGOL and 
FWS internal portal accounts by default. Contract your GIS administrator if you have questions 
or need additional publishing rights. Outside users check with your own GIS staff.  

a. Sign in to your available portals so they are available in all mapping.  
b. On the settings page go to portals and hit Add portal. FWS users have 3 available and 

are listed in this screenshot 
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c. AGOL – ArcGIS online is a server/service hosted by ESRI. Data is housed on their server 
under your account and can be shared with others publicly. Since this is on a public 
server the type of data you can share or host on AGOL is limited to non-sensitive data 
and if shared publicly must comply with public data standards such as 508 compliant. 
Address is simply arcgis.com. You will log in with the FWS email and credentials. May 
need either your PIV card on government systems or Authenticator for 2 step 
verification. https://www.arcgis.com/  

d. FWS GeoPortal is a very similar. It is the same ESRI software platform product but is 
running and data housed on a FWS server behind a DOI firewall. This should be used for 
any sensitive data not open to the public. As such the content hosting is much more 
flexible on what you can put up. You must still follow agency guidelines for any PII. 
Address is https://gis.fws.gov/portal/ and if prompted use the DOI or FWS account at 
login not AGOL. 

e. The 3rd is InsideFWSMaps. Very similar to GeoPortal as anther internal server. 
https://maps.fws.doi.net/portal/ . However, InsideMap is an older version being 
replaced by GeoPortal. It still has some data from previous projects so can use if needed 
but is being phased out so use GeoPortal for all new cloud hosting.  

f. Once all your portals are connected they should reconnect automatically when you 
open ArcPro if you are online. The internal servers might not log in automatically if you 
are on a public network so might need to use re-log in if they don’t connect outside of 
the office. Data in your maps should be available from all portals at the same time. 
However if you want to edit any data it can only edit from the “Active” portal. Thus if 
you are editing a specific dataset then right click on that portal to set as Active 

 

5. Options/Preferences: Go to the Options Menu for additional custom settings. Go down the list 
and set any defaults that are useful to your situation such as units, file locations etc.  

a. General: Likely should set a new default location for your data. If not defined ArcPro 
tends to save to a local folder in your Windows Documents Folder. However, if you are 
in a collaborative workplace you might want it stored on a central server location or if 
others would open the Project they would be missing any data stored on your local hard 
drive. Specific maps you might want to later redefine individual geodatabases in each 
project folder specific to that project. You would do that here also. However, as a 
starting point I would make a default central folder, geodatabse and toolbox to point to.  

https://www.arcgis.com/
https://gis.fws.gov/portal/
https://maps.fws.doi.net/portal/
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b. Map & Scene: Main thing here is setting a coordinate system for the current map and 
your Favorites for future. Under Spatial Reference scroll through and find your desired 
coordinate system. Right Click on it and select add to favorites. This will be quicker than 
looking through the entire list every time.  

 

c. Editing: ArcPro editing is different than ArcMap where essentially all layers can always 
be available in editing mode any time not just in an edit session. Thus there is a chance 
of editing by mistake if you aren’t careful. Later we will cover turning off edit options for 
undesired layers. However, in the Options I like to keep “Automatically save edits” OFF. 
As well as “Enable and disable editing from the Edit tab” turned ON. These 2 features 
make editing a more intentional act so you both have to enable the edit mode like you 
did in ArcMap 10x as well as confirm saving a change in case you accidentally changed 
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something you didn’t want to. This is an extra step so if you are confident in your 
workflow you can skip this and work faster just be aware of what you are doing.  

 

d. Quick Access Toolbar: These are the tool buttons at the very top of the screen. Unlike 
the ribbons these tools don’t move or change so are always available. My preference is 
have as many common tools available for quick access so I add and organize most of 
these available buttons. 

 

e. You can also customize each ribbon if you want further tools rearranged. Right click on 
the Ribbon and choose customize.  
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6. New Map or Template: Highly recommend setting up and using a map template. As most of 
your projects will probably start with similar data and similar layouts. Save time in recreating by 
setting up a general purpose map once and save it. Then reopen this map as your template to 
start from each time. Then use the Save As command to save it to a specific location for 
individual projects. If you want to secure this template so it can’t be accidentally overwritten 
then just set it to read only in the file properties.  

 

7. Add Data: Under the Map Ribbon hit the Add data button or if you customized the quick 
buttons at the top it may be there also. There are also additional options on the Add data drop 
down list (arrow on the bottom of the button). Navigate to your data and add to the map. 
Various predefined basemaps are also available on the basemap button and drop down list.  
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8. Catalog Pane or View: Use Catalog as another way to add data or a place to view files, move or 
create files. This is synonymous to ArcCatalog in the old ArcGIS 10x. On the View Ribbon you see 
2 options for Catalog Pane or Catalog View. Pane opens a side toolbox that you can either drag 
around floating or dock it to the side. This is easier for dragging and dropping or viewing while 
also using the map display. Catalog View opens the Catalog on the entire view screen and is a 
Tab along with your maps and layouts available. Better if you are doing more file management 
and want a larger workspace for your files.  

 

9. Folder Connections: In the Catalog it does not show the same Windows file structure you would 
see in explorer or in the Add data box. It only shows files or folders you are connected to. Thus, 
if you want a drive or a specific folder connected in Catalog you need to map it.  

a. In Catalog right click on the Folders icon and hit Add Folder Connection 
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b. Navigate to the drive or folder you want connected, select it and hit OK. Being more 
general like a whole root drive may be better if you will want items from multiple 
locations on that drive. If there is just 1 specific spot you want data from you can 
navigate down to subfolders which could be quicker to access but less broad.  

 

10. Working with Panes: “Panes” are popup windows with specific tools for various tasks in the map. 
Can include Catalog as we have just seen, geoprocessing tools, symbology, labeling. They will pop up 
when you click on something that requires more options. If closed with the X button in the top right 
corner they can come back when needed by hitting the originating button on one of the ribbons or 
right clicking context menus. However, I find it much more convenient to let them remain 
minimized/docked on the right hand side so they are quickly available as needed. Learn the habit of 
not closing them with the X. They will auto-hide if you just leave them and click on another tool or 
on the map. Sometimes they auto-hide too quickly when you still may want them visible. To dock 
it\hold it open, hit the pin button on the top of the tool. It will remain open until you unpin or X to 
close. To reopen just hit the tool listed along the right side.  
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11. Suggested Map Layers: For the type of wetland work proposed in this tutorial, Map layers that 
would be useful include 

a. Road and other Transportation layers 
b. Geopolitical boundaries such as Cities, County or State Lines, Townships and Sections 
c. Hydrology such as Rivers, streams and Lakes, NWI and RWI data, State protected 

waters, judicial ditch systems, HUC12 watersheds.  
d. Land ownership including Federal and State lands other conservation lands. 
e. Easements including FWS easements as well as other programs such as RIM, WRP, CRP, 

State easements.  
f. Environment & Habitat data such as Landuse/Land Cover, Natural Heritage or T & E 

data, Biological Survey data, prioritization maps. 
g. Soils maps, particularly with drainage properties/hydrology. Excessively drained to Very 

Poorly drained. Using MUName attributes for soil name class.  
h. Topography information including topo maps and any DEM LIDAR available at the 

highest resolution for your area. Much lidar includes 2ft contours and hillshade but we 
will clip and create this ourselves specific to a project location later.  

i. Aerial Photography. Suggest as many years as available. Often see things in 1 year that 
you may not in others as well as span wet and dry periods. Some photos may be 
available in an un-georeferenced form. We will cover georeferencing in a later section.  

12. Group and name data: Many layers in the map can clutter it and make it hard to find specific 
things. Group data by type under headings. Right click on the Project Map at the top of the list 
and choose New group layer. Rename it and drag layers into it. This way you can toggle entire 
groups on or off as needed. Rename all other data to be intuitive in the map not coded. 

 

13. Change Symbols: Customize layer symbols. In your table of contents.  
a. Either click on the symbol which can make the Symbology Pane appear on the left or 

right click on the layer and choose Symbology. 
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a. Change the symbol either from the Gallery of predefined symbols or the Properties 
where you custom choose your own fill or outline.  

b. Symbol properties of the overall layer can also change if the feature is displayed as a 
single type or broken by unique Values or other categorizations.  

        

c. Transparency is a common feature. To make an outline or fill transparent, hit the drop 
down for the color and choose color properties. Then adjust the transparency in the 
properties.  
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d. Save custom symbols. If you like a specific symbol and you want it quickly available in 
your symbol gallery, hit the menu at the top of the symbology pane and choose Save 
Symbol to Style. It will then be saved in your Gallery. I define the same Category for all 
my custom symbols so they are organized together.  

    

14. Labeling: Any features that need labels you can choose labeling options either by right clicking 
on the layer and choose Labeling Properties to open up the Label Pane or many features are 
available on the Label Ribbon tab at the top. Labeling can get pretty extensive with options. 
Much is trial and error or search many good video tutorials available online for specific 
functions. 

 

15. Create a Project Geodatabase: Many features of ArcPro are stored in a project geodatabase. 
Unlike ArcMap this is not optional. Every ArcPro project must have a database so if you don’t 
define one then it will create a default database. However, if a default one is used it could be 
stored locally not associated with the rest of your map data which may reside on a server for 
others to also use causing error or missing information if opened later. Or if not associated with 
the map may be inadvertently overwritten or deleted. So it is best practice to just create a 
database for each unique project. If you are using 3rd party tools like NRCS Engineering toolbox 
you could skip this as it will create a geodatabase in the process of using that tool if you do it 
early in your map workflow then define that database as your default map database.  
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a. Open the Catalog Pane or Catalog View 
b. Go to the Databases Folder and right click and hit New File Geodatabase 
c. Navigate to the folder where you will save your project. Best to have an individual file 

folder for each separate project. Keep all specific data and documents for that project 
together in 1 place. Give your database a name. 

 

16. Save your Project:  
a. Use the Project tab at the top left and choose Save or Save As 
b. Save it in the same project folder as the rest of the database and documents or other 

files for this project. 
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17. Set default project locations to the new project folder and geodatabase.  
a. This defines the default location for all future work to your project folder. Saves time in 

searching for locations to save or retrieve from as well as defines the new geodatabase 
to use when it stores things like annotations or other auto-created items.  

b. In the project tab at the top left choose options 
c. Under Project\Current Settings change each of the Location, Home Folder and Default 

Geodatabase to your project file.  

 

18. Set Selectable and Editable Layers: ArcPro makes it easy to edit almost everything. Often it is 
too easy and could edit feature you don’t intend to or get cluttered while trying to work with a 
single feature. You may want to edit a wetland polygon but accidentally select and delete or 
modify a background road layer. Because of this it is best to set up your map right away to make 
most base maps or simple display features not selectable and not editable to avoid issues. On 
the Map view table of Contents there is a selection button and an Edit button. Go to each of 
these and toggle off all layers that you don’t want selectable or Editable. Shortcut instead of 
toggling a long list is you can also right click on a layer and select make this the only 
selectable/editable layer. Same spot you can also toggle snapping layers if you want as well.  
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19. Create a Layout: The map view is where you do the full screen work and analysis. The layout is 
how it is displayed on a page which you can then print or export.  

a. This could be done now at the beginning of a project or template creation or done at 
the end of the project for final display. 

b. On the Insert ribbon at the top choose New Layout and pick your size format. 

 

c. On the layout tab you just created, again go to the Insert ribbon. Notice the buttons are 
different when on the Insert ribbon in a layout vs a map. Tap Map Frame. If you have 
more than 1 map in the project you can choose which one. Also can choose the extent 
from the list.  

 

d. Draw/Drag the Map frame on your layout page covering the whole page or part of it 
depending how you want it viewed.  
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e. You could repeat this process if you want multiple maps on your layout such as if you 
want a main map and an inset at a different scale. The Map frames from the same 
source map will have the same features displayed with the same symbology, layers 
toggled on or off, labeling etc although they could be viewed at different scales or 
locations. If you want a different map for the inset you would need to create a New Map 
frame separately up on the Insert ribbon, then import that to your layout.  

f. Note your map frame in your layout navigates separately from your active map so 
zooming in or out to a feature in the map view won’t translate to the layout. A quick 
shortcut in layout is right click on the map frame and choose zoom to last active map 
which brings you to the same location as the map view and you can adjust from there or 
also the Zoom to Map view button on the ribbon. 

     

g. Layout features like North arrow, Scale bar, Title and legend can be added from the 
Insert ribbon when in a layout view 

h. Legend: you probably don’t need every layer in the map on the legend. Expand the 
Legend list in the Contents Pane and toggle off items you don’t need. Double clicking 
any of the legend items opens a right pane for more individual options.  
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20. Navigation:  
a. Map view navigation is done with the Explore tool. This is located on the Map tab. Use 

the mouse scroll wheel to zoom in or out. Click and drag to pan. Hold down the shift key 
when you click and drag to get a rectangle zoom in box.  

   

 

b. Identify with the explore tool. If you click on the map without scrolling it works as an 
identify tool and will pop up a box with attributes about the layers you clicked on. You 
can change the way this identify tool works or disable it on the Explore drop down list.  

 

c. Additionally on the Map ribbon if you enable the quick shortcuts, the explore tool and a 
few other navigation buttons can be available at the top of your screen.  
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d. Layout navigation is a little different. On the layout ribbon you see some navigation 
tools that navigate you around the layout page itself. In order to navigate in the Map 
Frame on the layout you need to first hit the Activate Map button on the Layout ribbon 
or on the toolbar at the top of the screen. Then you will be working in the map frame 
and can use the Explore tool to navigate in the map. Hit the button again to exit active 
map and resume layout navigation.  

 

21. Setup Analysis tools: Geoprocessing analysis tools are available on the Analysis ribbon. 
Shortcuts in the dropdown gallery on the ribbon or a full suit in the toolbox by hitting the red 
Tools button on the ribbon.  

      

a. Add tools you use often to the gallery by locating in the toolbox and right click and Add 
to Analysis Gallery. Then at the bottom of the Gallery you can choose customize and 
rearrange if you want to.  
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b. Suggested tools for wetland workflow: 
i. Data Management tools > Raster > Raster Processing > Clip Raster 

ii. 3D Analyst Tools > Raster > HillShade 
iii. 3D Analyst Tools > Raster >Contour 
iv. 3D Analyst Tools >TIN Dataset > Create TIN 
v. 3D Analyst Tools >Area and Volume > Surface Difference 

22. Your map should now be ready to use. Save any changes. This is either your template to create 
other maps from or possibly a new stand alone map. If you opened this map as a template then 
you already have all the layers imported and symbolized. You just need to do the final steps of 
creating the unique database and saving it all in it’s own new file location. 

Aerial Photography & Other GIS Resources: 

1. Air photo uses: Aerial photography may be one of the most useful tools in wetland and 
conservation work. Particularly a large span of years of air photos can show the history of a site 
or variations in hydrology with wet or dry cycles. May see the full extent of a wetland during wet 
years or how it looked pre-drainage. May also see a year that it was drained or certain years 
where features like buried drain tile show up well due to surface disturbance or vegetation 
changes. Seek as many air photo resources as you can find for a site.  

 

2. Resources:  
a. Basemap: A few air photo options are available from the ArcPro basemap. Most of it is 

what they refer to a “Firefly” which is a cartography service that mixes various sources 
at different scales to get a full composite image across the globe. Has good coverage of 
almost anywhere and quickly available without additional downloads. Downside is for 
the most part you don’t know when the image was taken and the image used may 
change for any particular location over time as they update their system. 

b. Map Services: Various servers host their data through a server connection such as a 
WMS (Web Map Service) server. If you find a data site that mentions a server 
connection you can map to it in your catalog pane then add data from it like any other 
file location.  
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i. Open the Catalog pane and right click on Servers and choose the type of service. 
In this example for Minnesota we use the MN Geo WMS Service. Type the 
Server Address. Some servers may require a User name and password. If not 
such as MNGeo then leave blank.  

ii. https://imageserver.gisdata.mn.gov/cgi-bin/wms?  

 

c. NAIP photos: NAIP is a program run by the USDA FSA originally used for crop 
compliance but has expanded to many uses. Available across most heavy agriculture 
areas of the country and new imagery flow typically every 2-3 years for many areas. 
Available back to the early 2000’s when the switched from slide film. It comes already 
georeferenced/orthorectified in mosaics covering usually at least by County but 
sometimes by full state depending where it is hosted. The MNGeo service listed above 
hosts the NAIP imagery so it can be served online from there. If you have a slower 
internet connection or otherwise prefer to download your data locally you can 
download NAIP from many sources. These are a couple. 

i. https://nrcs.app.box.com/v/naip/folder/17936490251 
ii. Choose your year, state, type (C refers to color infrared & N is Natural color, 

then the county file. Unfortunately NAIP hasn’t adopted intuitive naming so 
their file names are a coded value. On the root directory look for a folder called 
reference files and within that a file called NAIP file names for the directory of 
state and county codes. Recommend renaming after you download to a State-
County-Year file name.  

d. MNGeo: Aside from their map server can also download mostly FSA NAIP photos from 
here for MN. http://www.mngeo.state.mn.us/chouse/airphoto/  

e. Datagateway: Another place for mostly NAIP photos nationwide as well as other GIS 
layers. https://datagateway.nrcs.usda.gov/  

f. Digital Globe: Government agencies can get a free account. It has ongoing recent 
satellite imagery. (It has an option for smart card log in but don’t use that as it is only for 
DOD, create a standard user account.) Often you can find images only a month old and 
good resolution.  

i. https://evwhs.digitalglobe.com/myDigitalGlobe/  

https://imageserver.gisdata.mn.gov/cgi-bin/wms
https://nrcs.app.box.com/v/naip/folder/17936490251
http://www.mngeo.state.mn.us/chouse/airphoto/
https://datagateway.nrcs.usda.gov/
https://evwhs.digitalglobe.com/myDigitalGlobe/
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ii. It is a little clumsy to use but essentially use the Map to zoom to the area of 
interest.  

iii. Use the Draw tool to outline the area you want to clip out which should then 
have a red box. 

iv. Then on the pencil icon hit Continue to Advanced Search.  

    

v. Choose the year/date available in the list you want and at the bottom of the list 
hit continue and With Selected “Create Mashup” and give it an intuitive name. 

    

vi. Once ready it will be available for download in the account Library.  
vii. There are many attribute files associated with it which you can use if you want 

to download the whole package but for simplicity all you really need to 
download is the largest TIF file which is the image itself.    
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g. DNR Landview for MN has historic photos you can download. On the map, zoom to the 
area of interest and turn on the Historical Air Photos index. Use the identify tool to 
select one of the dots and it will open a page you can download the image from. These 
are not georeferenced. For my area this is 1938 and 1954. The 38’s are great as that is 
the oldest photos I have found and good to see historic conditions before some of the 
tile drainage work. http://www.dnr.state.mn.us/maps/landview/  

 

h. Earth explorer has a lot of photos available from a broad time range nationwide but it is 
a little cumbersome at first. I found 1940’s, 60’s, 70’s 80’s color infrared used in the NWI 
program and 90’s. Use the map, click on a location of interest, Click on data sets and 
check boxes for what you want to search. Most of the good stuff is under aerial imagery 
and aerial photo singe frames as well as NAPP and NHAP. Then click results Click the 
foot icon to see the area it covers then download the ones you want. 
https://earthexplorer.usgs.gov/  

 

http://www.dnr.state.mn.us/maps/landview/
https://earthexplorer.usgs.gov/


24 
 

i. FSA Compliance Slides have been scanned and cover much of the 1980’s and 90’s for 
MN. They are individual mile sections organized by county, township, section and year. 
Good Complete resource. A few errors here and there so double check the image. Some 
were turned or flipped when scanned so check the orientation and adjust in an image 
editing software if needed. These are non-georeferenced so would need to manually do 
it if needed. http://geo.lib.umn.edu/ I would start in the AerialSlides2/ directory for 
most of the FSA slides. However you could explore other areas for additional data.  
 

3. Georeferencing: This is giving spatial reference to the photo in GIS. Otherwise, it is an image 
with no indication of where it belongs on earth or scale. In addition, photos can be rectified in 
the process which is to adjust scale and curvature of the photo to lay properly over the 
landscape. Distortion can come from an angle of the photo relative to the ground if not perfectly 
perpendicular or from curvature of a glass lens more so on the outer edges of an image giving a 
fisheye type of distortion. These could affect how it lines up with other GIS layers as well as 
proper distance or area measurements referenced from the image.  

a. Have a map open with your other reference layers such as an already 
referenced/rectified imagery. Often for a reference image it is best to use something of 
good quality and as close to the same year as you can for the desired photo so features 
haven’t changed much.  

b. Download your unreferenced photo such as from one of the resources listed above.  
c. Add it to your map from the catalog or Add Data. Since it has no reference it will be in 

the contents but not displayed on the map.  
d. Have your photo selected on the contents list, then on the Imagery Ribbon hit the 

Georeference button. This will open a new Georeference ribbon.  

 

 

http://geo.lib.umn.edu/
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e. Zoom/Pan your map display to approximately the space and scale the desired image will 
be. Have the photo selected in the contents and hit the Fit to Display button on the 
Ribbon. This will place your photo on the screen in your work area. Notice in this 
example the photo is tilted. That will be corrected in the rectification.  

 

f. Identify common features you can see in both the desired photo and your reference 
image. Again use a reference photo from the same time period if you can so land 
features may be similar. USGS DOQ (Digital Orthophoto Quadrangle) imagery is 
available for most areas. Often this is the earliest high resolution quality 
georeferenced/orthorectified imagery. For MN this is from the early 1990’s so I often 
use this for earlier photos. They are black and white imagery but good quality. Find 
items like road intersections, buildings, prominent trees, etc.  etc. Note items that might 
move slightly such as field boarders or wetland edges may not be great. The smaller and 
more precise a feature is the better.  

g. Place control points linking features in the target image to the reference image.  
i. Zoom to your first feature such as a road intersection 

ii. Use the “Add Control Points” tool from the ribbon.  
iii. First click on the target image on your reference item. 
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iv. Then turn off the target image in the contents and find the same feature on the 
reference image and click on that same feature spot.  

 

v. You now placed your 1st reference point and the target photo should adjust to 
the new location.  

vi. Holding the C button allows you to click and drag/pan the map while in the 
same tool.  

vii. Repeat this process around the photo placing more control points. Best to start 
the 1-3 points as far distributed across the map as possible as this will best set 
the initial scale and orientation making the rest easier.  

viii. The first three only set scale and orientation so no distortion. As you place more 
you will notice the 2 points may not line up well. That is because of photo 
distortion which will be corrected later if you have more points. To get even 
warping of the image to correct distortion you need points distributed as well as 
possible across the whole image. Imagine taking a flat sheet of paper and laying 
over a globe. It will be wrinkled and not line up in spots. The rectification will 
turn that paper into a rubber sheet and stretch or warp areas to fit to control 
points.  

ix. Open the Control Point Table on the Ribbon which you can select individual 
points and delete them if you want or see which have high error and adjust. 
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x. After placing as many good points as you can, go to the Transformation button 
on the ribbon. Choose the highest transformation you can with the number of 
points you have. Minimum is 3 to scale and orient the image. You should try for 
at least 6 to get a 2nd order transformation which will adjust minor distortion if 
not a 3rd order if you can. You will notice after the adjustment the image is 
warped into a shape to match the reference photo and control points.  

 

xi. If you are satisfied with the Georeference then hit Save on the ribbon and it will 
save that transformation to the image permanently. If not, add or edit more 
control points before saving. After Saving, Hit Close Georefrencing Button on 
the Ribbon to return to the rest of your workflow or repeat by selecting another 
photo. 

h. Notice if you ever transfer this photo and want to retain the reference information, 
there will be a file associated with it by the same name but with a “wx” extension to it. 
Transfer that world file with the image.  

 

This Georeference process could also be used on non-aerial images like tile drainage maps as long as you 
have some type of reference points. GPS readings could also be used for features if needed. 
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Other data sources important for mapping 

1. Historic Plat Maps & Topo Maps: 
a. Why? Old maps often reference land features prior to conversion so can identify 

locations or features that previously existed. Old maps may indicate features that are 
important in cultural and historical preservation reviews/Section 106 compliance. 
Sometimes features line early settlements, native American villages, old trails etc may 
be recorded.  

b. Original land survey. Mid to late 1800’s. Can choose georeferenced Plat download 
option https://www.mngeo.state.mn.us/glo/index.html  

 

 

 

c. USGS Topo Maps. 1:24000 scale quadrangles from the 1950’s-1960’s are generally good 
quality and have coverage across most areas. Can download georeferenced quadrangles 
https://ngmdb.usgs.gov/topoview/viewer/  

https://www.mngeo.state.mn.us/glo/index.html
https://ngmdb.usgs.gov/topoview/viewer/
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d. Most cultural artifact sites are public for sensitive and private information. However, Mn 
has a tool to identify within a section if there are known sites. This is a web map not 
available in Arc GIS but can be useful to reference and cue you that there may be 
something more.: https://osaportal.gisdata.mn.gov/OSAViewer  

 

2. AGOL Public data 
a. Many layers have been published by other entities and shared publicly through ArcGIS 

Online or internally by your own agency. To add data from a public portal first make 
sure you are logged in to that portal and that the portal you wish to get data from is set 
as your “active portal”. 

b. From the Project Menu (top left), click on Portals, Add Portal if you haven’t already (See 
page 4 above). If you need to activate one click the 3 dots to the right of the name and 
“Set as Active Portal” 

 

https://osaportal.gisdata.mn.gov/OSAViewer
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c. Go to the Catalog Pane and Portal tab on the top of it. Various source headings are 
listed such as your own AGOL data if you published something, items from within your 
organization or AGOL public data on the Cloud button. Choose your source and can use 
the search bar if needed.  

 

3. Soil Maps 
a. Why? Soils are the basis for many ecological function. Particularly view Drainage class to 

see how well this soil is drained or holds water. View soil map unit name to get general 
description of sand, silt, loam clay etc. Depression in poor soils may not hold water even 
if enhanced.  

b. Can stream from web in ArcPro. Directions above for accessing data from AGOL portal. 
In the Portal catalog go to the living Atlas which is the cloud icon with the book. Search 
for SSURGO. Many classifications listed there. 

i. USA Soils Map Units are a vector layer that is a good outline of the soil unit. I 
would add, turn to just an outline for display and turn on “muname” as the label 
class to display the soil class name.  

ii. USA SSURGO – Drainage Class. This will tell if the soil is dry to mesic to wet. Very 
helpful in upland seed mix planning as well as knowing if something will pond 
water well. 

iii. USA SSURGO – Soil Hydric Class identify soils that were formed under wet 
conditions thus historically may have been ponded.  

iv. USA SSURGO – Flooding frequency is only for areas along riparian zones 
identifying floodplains. I usually don’t use this one 

v. USA SSURGO – Hydrologic group is only really needed if you are doing 
hydrologic modeling of runoff. It predicts infiltration rates.  
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c. Outside of GIS you can also run soil reports on the USDA web soil survey. 
https://websoilsurvey.nrcs.usda.gov/app/WebSoilSurvey.aspx 

 

4. Wetland Inventorys: 
a. National wetlands Inventory. Is a database that has a long history and available nation 

wide. It does miss a lot of small wetlands or drained wetlands but does include more the 
easily identifiable basins and provides a classification to them giving you an indicator of 
wetland types. Easiest sources is again from the AGOL portal. Search for “USFWS 
National Wetland Inventory 

 

b. RWI or Restorable Wetlands Inventory is a project initiated by Ducks Unlimited where 
potentially restorable basins were mapped using air photos and topographic data. Again 
not comprehensive and has error or missed basins as large scale rapid mapping projects 
are not an easy task but gives more detail than NWI and areas to cue in to. Easiest 
source is the AGOl portal searching for Minnesota Restorable Wetlands: 

 

https://websoilsurvey.nrcs.usda.gov/app/WebSoilSurvey.aspx
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c. State Public Waters: This is an important layer identifying those water bodies or water 
ways that are jurisdictional waters of the state. These means they are managed by the 
DNR and activities involved in those waterbodies are permitted through the area 
Hydrologist. Available on AGOL portal as “Minnesota Public Water Body” 

 

d. County Drainage Systems: These are legal judicial ditches which may be open ditches or 
county tile lines. These are managed by the county or watershed districts with legal 
authority. Landowners benefiting from these lines pay ditch assessments toward their 
use and maintenance. Any modification to these lines must be done under permit and 
review by the drainage authority.  

i. Unfortunately there isn’t a good single source for this data and every county is 
different is if they have ditches digitized and their willingness to share. Contact 
you local counties drainage authority to inquire on getting data.  

ii. Some are listed here: https://gisdata.mn.gov/dataset/water-public-drainage-
systems 

iii. Also many counties host online maps that have county data such as tax parcels 
but many of those maps also have county ditches available to toggle on. Can’t 
use that in GIS but can view on the web map then transfer knowledge to your 
own map. Most Mn counties use a service called “Beacon” so search for that 
and your county. https://beacon.schneidercorp.com/  

5. Land Ownership & Easements: Important to know who owns what or what easements might be 
covering areas.  

a. FWS search in the Portal for “FWS National Realty Tracts” this will have up to date fee 
title and easements.  

b. In MN most state data can be found here: https://gisdata.mn.gov/ 
c. Search for state DNR land, RIM, WRP, CREP easements. Prairie bank easements etc. 
d. CRP layers are held by the FSA office and generally not made public due to their privacy 

sharing rules. FWS has had some opportunities to share layers in the past under specific 
licenses. Check with your regional GIS coordinator for current status or inquire at your 
local county office if you need to request a specific project if they are able to help with 
that. Would need landowner consent for that site to accompany the request.  

 

https://gisdata.mn.gov/dataset/water-public-drainage-systems
https://gisdata.mn.gov/dataset/water-public-drainage-systems
https://beacon.schneidercorp.com/
https://gisdata.mn.gov/
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6. Biological data 
a. Minnesota has “Potentially Undisturbed Lands” layer on AGOL. This was a mapping 

project in the prairie areas of MN identifying land without a cropping history that is 
likely “Native”.  

b. “MBS Biodiversity Significance” available on AGOL for MN are prairies that have had 
surveys done and rated the biodiversity found.  

 

c. Natural Heritage data: Threatened and Endangered species location data is often 
protected due to sensitive nature of it. Data can be acquired by your office for specific 
needs under a license or MOU from the state DNR. Talk to your regional GIS coordinator 
if you need access to such information.  

d. Critical Habitat is a less specific T & E identification. Can be found on AGOL under “FWS 
HQ ES Critical Habitat”. Identifies general habitat’s of concern not specific locations 
found.  

e. Other priority maps contact agencies or partners may provide information specific to 
project areas and goals. Examples may include the FWS HAPET office produces 
“Thunderstorm” maps of modeled waterfowl usage. Other focus area maps  
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LIDAR 

1. LIDAR (Light Detection and Ranging) is crucial in wetland restoration design. It is essentially a 
laser scan of the earths surface taking elevation readings in a grid of a given area. Many areas of 
the country now have LIDAR available and often at scales of 1 meter or better resolution.  

a. Advantages of LIDAR is it is continuous coverage where it would take a ground survey a 
long time to grid an entire area. It is also available for project review right now in 
preliminary stages often before any field visit or survey even takes place. You can get a 
feasibility preview of a project from the desktop and save time and money on field 
work. On flat hard ground like exposed fields accuracy can often be within 6 inches or 
less. Good for general landscape and watershed scales. 

b. Disadvantage is it is a single snapshot in time so doesn’t account for features that may 
change. It doesn’t penetrate water so only get water surface elevations. Readings 
through thick vegetation can be scattered so you may get the tops of some vegetation 
not ground so heavy vegetation like cattails or trees may not produce a good accurate 
reading. Keep precision in mind and even in good conditions I wouldn’t assume better 
than 6 inch accuracy or often better to default to 1ft intervals. Not for use on small 
scales as the scan may not pick up small nuances like small ditch bottoms or narrow 
waterways etc.  

c. Lidar can show many detailed topographic features from waterways to hilltops. Even 
drainage if the LIDAR was taken shortly after installation. In this example we see where 
drain tile was installed all across this field and the soil is left slightly mounded as they 
refilled the trenches over the tile. LIDAR picked up this variation and can see and map 
the drain tile from LIDAR.  

 

d. In Minnesota LIDAR is available here under the FTP download area: 
https://www.mngeo.state.mn.us/chouse/elevation/lidar.html Suggest using the county 
mosaic. Open the FTP link, County Folder and the elevation_data.gdb.zip file. They are 

https://www.mngeo.state.mn.us/chouse/elevation/lidar.html
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very large files for each county so best with high speed internet and ample storage. 
When downloaded, rename to intuitive naming as needed.  

e. Individual online Lidar maps can be made at 
http://arcgis.dnr.state.mn.us/maps/mntopo/  

2. Clipping LIDAR 
a. If you are using NRCS Engineering tools skip all these next steps and go straight to step 3 

(Page 33) describing the NRCS tool which automates and combines these steps.  
b. On a large scale such as a county sized file it can be very large and slow the processing 

of the computer as well as display can be less decerning at that scale. Thus best to clip 
LIDAR down to your specific project area. This can be done with individual 
geoprocessing tools built into ArcPro or there are 3rd party tools or scripts that you can 
add to automate some of these tasks such as the NRCS engineering toolbox.  

c. Assuming in your map setup you already have general base data such as air-photos, 
boundaries etc, a project folder is made where this project is saved and you have a 
default geodatabase made for the project in your folder.  

d. Create a AOI (Area of Interest) Layer which will serve as the clipping outline fore LIDAR.  
i. In the Catalog pane navigate to the folder and geodatabase you created for the 

project. Right click and Choose New Feature Class 
ii. Name it AOI, Choose Polygon as the Type, Hit Next Twice to get to the Spatial 

Reference page and choose the coordinate system you use for your project. 
Then hit finish 

   

iii. Change the symbology of the AOI layer if it helps you. Often a hollow outline.  
iv. Open the Editing Ribbon, Start Editing, Hit the Create Button, Select the AOI 

layer from the Create Features list Pane. 
v. Draw the Clipping area. Suggest more than just the property boundary. You 

want all areas that impact your project particularly what drains into the project 

http://arcgis.dnr.state.mn.us/maps/mntopo/
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so you can see and anticipate possible drainage coming in or extent a project 
could back water over a property line during high water. If doing watershed 
modeling you may want the entire watershed area that flows into the project. 
HUC12 watershed layers can be helpful displayed while drawing. Draw a single 
polygon only in this layer.  

 

vi. Saved edits on the Ribbon with the Save icon.  
e. Clip Raster: On the Analysis Ribbon, Hit the Tools Button 

i. In the list of Toolboxes look for Data Management Tools\Raster\Raster 
Processing\Clip Raster. If you had setup this tool as a shortcut it may also be in 
your gallery tool list on the ribbon.  

 



37 
 

ii. Input Raster pick the lidar layer to be clipped. Output Extent pick the AOI layer. 
Output Raster Dataset pick the location you want to save this clipped layer. 
Usually in your project folder or in the file geodatabase in that folder. Final 
option is the check box for “Use Input Features for Clipping Geometry” which is 
optional. Unchecked it will clip the raster to a square box encompassing the 
extent of your AOI. Checked it will clip to the exact AOI line regardless if it is 
square or not.  

 

iii. Hit run at the bottom of the toolbox to run it and when done it will add the 
clipped layer to the map.  

iv. For display purpose, suggest changing the symbology of the clipped lidar. Right 
click on the layer and choose Symbology to open the symbol Pane. By default it 
is greyscale. Most common color scheme is “Elevation 1” which uses a gradient 
of blue for lowest through green, yellow, brown then white as highest.  
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v. Using your Explore Tool you could click on any spot on the LIDAR and get the 
elevation of that point in the LIDAR layer.  

f. Hillshade: Not needed for analysis but for better display you normally want to create a 
hillshade layer for your clipped LIDAR. This gives a shadowed sunlight direction 
perspective for the Lidar or can be used over aerial photos to give a 3D perspective.  

i. On the Analysis ribbon hit Tools. In toolboxes go to 3D Analyst 
Tools\Raster\Surface\Hillshade Or may be on your gallery tools on the Ribbon.  

    

ii. Input raster is the clipped Lidar. Output Raster save in your project folder or 
geodatabase and call it Hillshade. Normally can leave other default settings. Hit 
Run at the bottom to finish. 

iii. For display a Hillshade needs to be set transparent. Open the Symbology for the 
Hillshade layer. Under the Color Scheme drop down list choose Format Color 
Scheme and set Transparency to about 60% or whatever you like to see for 
strength of effect. 
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iv. Keep the Hillshade layer higher in your contents list than the Lidar layer so the 
hillshade drapes over LIDAR or the same with air photos.  

g. Contours: These are topographic lines indicating elevation changes so all points along a 
single line are the same elevation. Very useful for quickly glancing at a map and seeing 
how much elevation change over an area or for wetlands to see a potential wetland 
edge outline or in embankment design to see where ends of a dike may join a natural 
hillside.  

i. On the Analysis ribbon hit Tools. In toolboxes go to 3D Analyst 
Tools\Raster\Surface\Contours 

ii. Input Raster select the clipped lidar. Output feature class this will be saved as a 
feature class or shapefile. Usually save in your project folder and in the 
geodatabase for your project. Call it something like Contours_1ft. (Can’t start 
with a number and no spaces). Choose your interval which is normally 1ft. Lidar 
is probably not accurate enough to realistically get more than a 6 inch resolution 
so 1ft is decent confidence for real world application with still good resolution. 
Rely on field survey for anything more accurate.  Usually leave other options 
default and hit Run at the bottom to finish.  

         

iii. Suggest changing the symbology to a thin black line such as Black 0.5 thickness 
h. Your project LIDAR is now ready to use. 

 
3. NRCS Engineering Tool (Alternative to built in ArcPro tools described above, Skip this section if 

not using this Add-in toolbox) 
a. This is a handy tool for wetland work developed by the NRCS. It is an extension that can 

be added to ArcGIS Pro toolbox. There was a previous version for ArcGIS 10x. Make sure 
to download and install the Pro version as the ArcGIS 10x version will not work in Pro.  
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b. Download from here: https://github.com/USDA-NRCS/NRCS-Engineering-Tools---ArcGIS-
Pro.git A little confusing site but hit the “Code” button and choose Download from the 
dropdown to get the whole package instead of downloading individual file components 
in the list.  

 

c. Unzip the file and place the entire folder somewhere that will always be available when 
you open ArcPro maps. This could be on your root C: drive for individual use or if you 
want it to come up in your map template from any computer using that same template 
from a server then store on the server location such as the same location where your 
template file is saved. For me (W: is a local server drive for our office GIS), I Have a 
W:\ArcPro\ folder which holds the project template map, default toolbox, default 
geodatabase and the NRCS Engineering toolbox folder.  

 

d. Open ArcPro and install in your map template if you want this to be in all future maps or 
an individual project file. On the Insert Ribbon Choose Toolbox and Add Toolbox 

 

https://github.com/USDA-NRCS/NRCS-Engineering-Tools---ArcGIS-Pro.git
https://github.com/USDA-NRCS/NRCS-Engineering-Tools---ArcGIS-Pro.git
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e. Navigate to an Select the NRCS Engineering Tools Pro.tbx 

 

f. The toolbox will then appear under the Catalog under toolboxes. You could also add any 
of these specific tasks to the Analysis ribbon gallery as described in the Step 21 of the 
Original map setup and customization directions above.  

 

g. Before using the NRCS tools, If you have the option to enable or disable editing on the 
Edit Ribbon you will need to Enable Editing. These tools automate some tasks which 
includes the need to be able to edit. Also if you were doing any other editing in your 
map you have to Save edits before running the tool. The tool can’t create new files 
while an active unsaved edit session is going.  

h. Clipping and displaying LIDAR with the NRCS tool once installed as described above.  
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i. Open the NRCS toolbox as displayed above and go to Watershed Tools, 
Watershed Delineation and Open the 1. Define Area of Interest script 

ii. Select Workspace is your project folder. The tool is going to automatically create 
a geodatabase in that folder using the project name and it will save the various 
layers it creates in that database. Important note, the NRCS tool will fail if there 
is a space or special character in the file name path. Make sure the entire file 
path has no spaces and use an underscore as a replacement if needed.  

iii. Input DEM is the original county level larger LIDAR you want to clip. 
iv. Pick what units your LIDAR is in which in my case is feet. And pick the contour 

interval which is usually 1 foot interval lines.  
v. The area of interest, if you already had created an AOI layer and drawn it you 

can use that but if not hit the pencil icon and it will create a new AOI layer for 
you and start an editing session. Use the polygon tool built into this toolbox and 
draw the area you want to clip on your map. Choose an area encompassing all 
topography that would affect the project. Any areas that you may want 
incoming drainage elevations from or see how far water might back up if 
impounded. If doing larger watershed scale work might want the whole 
watershed area outlined.  

 

vi. Hit Run to finish and create. This may take some time to process so let it run.  
vii. When done it will create a DEM clip of your LIDAR, a hillshade, a depth grid 

which shows potential depressional areas, a contour layer and the AOI layer.  
viii. I tend to turn off the depth grid unless specifically highlighting depressions or it 

can be used for wetland mapping. Also turn off the AOI outline. 
ix. Contours I suggest turn off labeling (Right click on the layer and hit “Label” or it 

will slow redraw every time you move the map. Whatever is comfortable to you 
but I find the major and minor contour lines distracting so I simplify in the 
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symbology pane to a single feature option and change the line type to black 0.5 
thickness so it is visible but not distracting.  

 

i. Feel free to explore the other tools in the NRCS toolbox. Additional automation steps 
include creating a streamflow network and mapping the watershed which can be helpful 
in further design workflows. Other areas of the toolbox can be used for assisting with 
runoff curve calculations and more. With he toolbox download is a tutorial.  

4. After creating your topography data I suggest lumping all that into a single new group layer in 
the contents list so they can all be toggled on or off as a single unit. With the LIDAR, Hillshade 
and contours.  

Importing Survey Data and merge with LIDAR 

1. If ONLY using 1 elevation source like ONLY LIDAR or ONLY field survey, skip sections about 
merging data. Just Conver to points (Step 5) Calculate meters if unit conversions are needed 
(Step 6) and create TIN (Step 8) 

2. Purpose: Lidar has broad coverage but sometime low detail. Field surveys have specific and high 
accuracy detail but often limited coverage. It is best to merge the 2 for final design planning to 
get more complete coverage. 

3. Field work:  
a. This tutorial will not cover field surveys as there is a lot of variation in hardware, 

software and methods. A previous tutorial was made for one method using Tribmle R10 
and TSC7 tools. This is available at http://skralston.com/USFWS/ and look for “Using 
Trimble R10 and TSC7 data controller for VRS-RTK GPS surveys”.  

b. Key points for whatever method of field survey you do are: 
i. Spend efforts on GPS for crucial points such as structures, intakes, outlets, 

flowlines. Important limiting factor locations like property lines that you can’t 
back water beyond or liability and infrastructure.  

ii. Survey areas LIDAR can’t reach like narrow waterways, subsurface locations like 
tile lines or culverts. Below water lines or in thick vegetation where LIDAR may 
not have been accurate.  

http://skralston.com/USFWS/
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iii. Can spend less field time in areas LIDAR captures well such as hard wide open 
surfaces or areas where being within + or – 6 inches isn’t critical.  

iv. Grid your survey at a resolution equal to your LIDAR or close enough that you 
get the topographic definition required for proper design interpretation. More 
points in areas of greater change.  

c. Export your survey to a shapefile when finished. In Trimble Access this is in the Job 
menu. 

 

4. Transfer that shapefile into your ArcPro project folder then Add it to your map.  
a. Define a coordinate System for the survey file. Some programs like Trimble don’t have 

projection files imbedded as part of the shapefile export. If this is the case you need to 
define the projection. 

b. From the Analysis Ribbon hit Tool button. In the Toolbox list go to Data Management 
Tools\Projections and Transformations\Define Projection 
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5. Convert LIDAR to Points 
a. You will convert your LIDAR DEM layer to a point layer. This is for a couple purposes. 

First it is easier to select and include/exclude vector point data to make a composite 
rather than dealing in rasters as well as it is easier to manipulate attribute tables for 
vector data which we may need to do unit conversions.  

b. Analysis Ribbon hit the tools button. In the list of geoprocessing toolboxes open 
Conversion Tools\From Raster\Rater to Point.  

c. Input choose the clipped Lidar layer. Output save as a feature class in the geodatabase 
in your project folder. Hit Run to finish. Could take some time depending on the size of 
the area.  

  

6. Convert from Feet to Meters. This is only if your LIDAR and/or the survey data is in feet or any 
other units aside from meters. Future processing we need units in meters. This also assumes you 
are working in a UTM type coordinate system where the units of the coordinate system are 
meters. Since we will be using this to calculate volumes think of the formula LxWxH. Length and 
width are latitude and longitude in a UTM coordinate system which are measured in meters. 
Thus for the calculation to work the height must be the same units as the L & W.  

a. Right click on the Lidar Point layer and choose open attribute table. 

 

b. Click the Add Button 
c. Make the Field name “Meters” and the Data Type Double (Double allows for Decimal 

places.  
i. If you are dealing in a shapefile not a feature class, then Double may also need 

to specify Precision and Scale. Precision is total digits and Scape is number of 
decimal points so 10 & 5 may be a good number for this application.  
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ii. Hit the X to close the Fields tab an Choose save changes when prompted.  

    

d. Right click on the meters column in the table and choose Calculate Field. As shown in 
this example The Input should already be set. Fill in your expression in the Meters = 
field. Double click the Field that contains your feet elevation value which here is 
grid_code. That adds that field to your expression. Then type or tap the multiplication 
symbol * and type the correct conversion which from feet to meters is 0.3048. Hit OK or 
Apply then OK and wait for it to finish the calculation. 

 

e. Repeat this process for your survey data if that is in feet units. Create a Meter field and 
calculate the feet to meters conversion.  

7. Select LIDAR that Intersects Survey Data: We will select and remove LIDAR wherever we have 
better quality survey data to replace it. (Skip this if not using Field Survey data) 

a. On the Map Ribbon open the Select by Location button 
b. In the tool set the lidar point layer as the input. Your Field survey points as the Selecting 

Feature. For search distance decide how far out from your survey point you feel your 
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survey point should represent actual vs the LIDAR data. Most often I use about 2 meters 
(when I do detailed surveys I try to take a survey shot within less than a 2 meter grid).  

 

c. You should now have all lidar points within 2 meters of a survey point selected. 
However, what we actually want is the opposite. We want to keep all LIDAR except 
those areas we have survey data. So right click on the lidar point layer and choose 
Selection\Switch Selection 

 

d. Next we want to create a layer of just those LIDAR selected points. Right click on the 
lidar point layer and choose Selection\Create Layer from Selection 
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e. You should now have something like this example where the field survey points here are 
red and the lidar points are blue. Refine as needed with manual selection or any other 
specific selections you need to get the appropriate combination you desire for survey 
data and lidar data representing your project area.  

 

8. Create TIN which is a 3 dimensional landscape of your project area from your combined 
elevation data. This is a TIN (Triangular Irregular Network) or essentially 3 dimensionally placing 
all your features in space and draping a surface over them.  

a. Under the Analysis Ribbon hit Tools (or possibly on your gallery tools shortcuts) and in 
the Toolbox list find 3D Analyst Tools\TIN Dataset\Create TIN. 

b. Output TIN, save this in your project folder location. TIN can’t go in a Geodatabase.  
c. Choose your coordinate system 
d. Input feature class include both the lidar point sub-selection layer you did AND include 

the field survey points. For both set the height and tag fields to meter which you had 
already calculated in a previous step for unit conversions. If you have multiple surveys 
or any other layers representing your landscape elevations include those as well. Run 
the tool to finish 

   

e. If you want to use this merged LIDAR and Survey data layer for more than future 
analysis and it is easier to work in standard units like feet you can repeat this process 
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but choose the feet units field in those datasets. Just remember for later steps of 
volume calculations in UTM systems you must use the meters version of the TIN.  

f. Additional option if you are using the composite survey TIN for more you could also 
create contours for that surface. We previously created contours for just the LIDAR DEM 
but can do the same from a TIN. In the toolbox list it is under 3D Analyst\Triangulated 
Surface\Surface Contour.  

Creating your virtual restoration feature (Dike/Spillway/Other Cut & Fill Areas) 

1. Create Feature topo layer: First step will be creating a layer that will represent the contour lines 
of your engineered feature. Think of this in terms of the same as reading a topo map.  

a. Example: A single line will represent a single elevation so something like an empty circle 
will be a flat area inside the circle. Space between lines is a slope. Slope is defined as 
Rise/Run so if you have 2 lines with one drawn at the top of a dike being assigned 
elevation 100 and the other drawn at the bottom of a dike being 90 then there is a 10ft 
rise between them or 10ft tall dike. If there is 50ft distance between those 2 lines then 
the run is 50ft. Thus the slope is 1/5 or 20% or in terms of dike work the terminology is 
often inverse so they would commonly say a 5:1 dike slope.  

b. Open the catalog Pane. Either minimized to the right side if you didn’t close it or 
available to re-open on the View Ribbon.  

c. Choose a location which likely should be in the Geodatabase in your project folder 
where other project layers are saved and right click in that location and choose 
New\Feature Class 

d. Give it an intuitive name and make the feature type be a Line.  
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e. In the Fields screen make 2 new fields. One called Feet and the other called Meters. 
Both should be set as Double for the data type to allow for decimal points. Fields could 

be added later from the attribute table but easier to do it from the beginning.  
f. Set a coordinate system then hit Finish to create it.  

     

g. Set symbology if you desire.  
2. Edit Feature: This is where you will draw the contour lines representing the engineering feature.  

a. 2 optional items but I feel makes editing any layer easier is set the layer you are working 
on as both the only selectable layer as well as the only editable layer. ArcPro can by 
default make all visible layers selectable and editable which can cause confusion or edit 
the wrong item.  

i. Right click on the layer and under Selection choose Make this the Only 
Selectable layer.  

 

ii. For Editing, on the top of the Contents box hit the pencil icon which brings you 
to the editing list. Either toggle all other layers off or Right click on your desired 
layer and choose Make this the only Editable Layer.  

 

b. On the Edit Ribbon if you have the option selected in the ArcPro options for manual 
control of Enable Editing then you first need to hit the Edit button on the Edit Ribbon to 
start editing.  
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c. Hit the Create Button to start drawing a new feature. A Create Features Pane will pop 
up on the right side. I like to Pin this Pane so it doesn’t minimize while editing. To do so 
just hit the pin icon at the top of the window Then my editing layers are quickly 
available instead of having to reopen the pane any time I need to switch layers or tools.  

 

d. Draw your centerline: 
e. Basics of drawing cut/fill contour features: You want your feature to overrun the 

ground level. Don’t end a contour line short of where that contour is on the 
representative ground level or essentially you are saying part of your landscape is 
suspended in mid-air or it is cut off. In this example I want my dike top to be 1439ft 
elevation. On my topo map I will draw a centerline contour line starting at or above the 
1ft contour lines of 1439. Doesn’t hurt to overshoot as anything higher than that dike 
top level will be selected out during the cut/fill analysis because it will calculate no fill 
for what is already below ground. Same for the bottom of the dike your lowest contour 
should be below ground or you are calculating a suspended or cut off dike and will get a 
wrong value in your fill volume. If you are calculating a cut like a spillway you want the 
opposite so your contour lines must overrun ground level above ground.  

f. In this visual example. We are building a dike to restore the wetland (right) but keep 
water off the road (Left). Red is the planned centerline of the dike which the dike top 
will be 1439ft elevation. Orange is the landscape contour line of 1439. Other thin black 
lines are 1ft contour lines. Notice my dike centerline is drawn past the 1439 orange 
contour line.  
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g. Create the Dike top: This is easiest by buffering your centerline if your feature is 
symmetrical. So if I want a 10ft wide dike top I buffer 5ft around my centerline (5ft each 
side of the line for a total of 10ft). Make sure your centerline is selected. On the Edit 
Ribbon Look in the Modify Feature Tools list for Buffer. Fill in your buffer distance and 
any other options desired and run the tool.  

 

h. Repeat this buffer to create the slope. Select the dike top line you just created and 
open the buffer tool again. First check about how tall your dike will be from top to the 
lowest point on the ground. This can be a simple estimate based on counting 1ft 
contour lines. In this example the dike is about 6ft tall. As previously mentioned we 
want to make sure the virtual dike we build extends below ground so I know here my 
bottom dike contour line needs to be greater than 6ft below the top. For simplicity I 
usually round up to the nearest 10 so I know my rise is 10ft for this virtual dike. Assume 
you want an even slope, pick whatever your slope dimensions will be. In this example 
we are building a dike with a 5:1 slope. With that slope we multiply 5 X 10 = 50ft of total 
run from the edge of the dike top to the bottom toe of the virtual 10ft tall dike (4ft 
below ground). Thus we enter 50ft as the buffer around the dike top and run the tool.  

i. Now you have 3 lines. Centerline, edge of dike top and bottom toe of the dike.  
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j. Assign Elevations to your lines: Right Click on the Cut/Fill layer and choose Attribute 
Table 

 

k. In the Attribute table enter in the Feet column whatever elevation each line should be. 
In this example I want a dike top of 1439 but want a 6 inch crown on it. So the centerline 
is 1439.5, The dike top edge is 1439. Then since I am overestimating to make sure the 
virtual dike is below ground my dike height for the 50ft buffer ring and a 5:1 slope is 10ft 
tall so the bottom elevation is 10ft below the top at 1429.  

l. Next convert those feet values to meters. Right click on the meters and choose calculate 
field. Fill in the Meters = field by double clicking on Feet to add it to the expression. 
Then manually type the conversion * 0.3048 and hit OK.  

 

m. The Dike contour line is now complete. Choose SAVE on the Edit Menu 
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n. You could add more if your project has multiple cut/fill areas. As long as the lines don’t 
overlap. If they do overlap then you could do them separately and run separate analysis.  

o. A cut like a spillway would work the same as the dike. Centerline the bottom. Buffer to 
get the flat width part of the channel. Buffer to get the top and overestimate but this 
time since it is a cut you add instead of subtract from the spillway bottom.  

p. A bench like off a road edge would be similar to a dike just only need to buffer 1 side.  
q. Uneven dikes such as a 10:1 front slope and a 5:1 back slope you would just have to do 

multiple buffers and use additional Edit Vertices or Split editing functions to remove or 
modify portions of the line for unequal sides.  

r. Excavating a polygon like a wetland you want cut down to a certain elevation use a 
similar process but you would start by drawing the wetland edge contour line all the 
way around and joining the ends of the line to make more of a polygon ring. Then buffer 
the inside by whatever slope distance you need down to the wetland bottom elevation. 

s. Drawing contours can get as complex as you want. Just envision where elevations are 
the same and draw with a line and the space between 2 contours of different values is a 
slope. This example is a virtual dike with a spillway in the center with entrance and exit 
ramps. The red lines were the contour lines used to draw it.  

 

3. Convert your virtual dike/Feature to a TIN 
a. Under the Analysis Ribbon hit Tools (or possibly on your gallery tools shortcuts) and in 

the Toolbox list find 3D Analyst Tools\TIN Dataset\Create TIN. 
b. Output TIN, save this in your project folder location 
c. Choose your coordinate system 
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d. Set the Height and Tag fields to Meters and Run it. 

    

e. You should now have a 3d model of your construction feature.  

 

Calculate Cut or Fill 

1. We now have a virtual model of our dike or other construction feature. We also have a virtual 
surface of the landscape from the LIDAR and/or field survey. Final step is to compare the difference 
between the 2 in order to calculate cut and fill volume and area.  

2. Run the Surface Difference tool: From the Analysis Ribbon open Tools and from the Toolbox list 
choose 3D Analyst Tools\Area and Volume\Surface Difference. 

a. For the calculations to work correctly in a UTM coordinate system your units in the input 
and reference layers need to be in meters. We can convert to others later. 

b. Input Surface choose the Cut/Fill 3d TIN layer you previously created.  
c. Reference Surface choose you Survey/LIDAR 3d TIN layer.  
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d. Output should be in the geodatabase of your project folder and name it intuitively.  
e. Run the tool 

    

3. You should finish with a polygon layer that shows cut and fill areas.  
a. In this example it displays by default, fill areas as blue and cut areas as green. For a dike like 

this the cut will be ignored and discarded as below ground.  
b. You should have your Fill feature entirely surrounded by cut areas as seen here which 

indicates you extended your virtual dike far enough for the slope to reach the ground and 
encompasses the whole extent of what you need to construct. If this is not the case and you 
see blue with no green surrounding it on all sides you may need to redo your Contour line 
creation for the feature and extend it further so the toe slope is not cut off. 

c. If your ground isn’t even you may have multiple polygons. Also if there were other areas of 
the TIN that overlapped non construction areas you might have extra cut and fill polygons 
that are irrelevant to the actual construction feature and can be discarded.  
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4. Edit to cleanup the Cut\Fill layer. 
a. From the edit menu, start editing.  
b. Reminder on editing it is often simpler to restrict editing to only 1 feature as well as 

selection to that feature to avoid editing errors.  
i. Right click on the layer and under Selection choose Make this the Only Selectable 

layer.  

 

ii. For Editing, on the top of the Contents box hit the pencil icon which brings you to 
the editing list. Either toggle all other layers off or Right click on your desired layer 
and choose Make this the only Editable Layer.  

 

c. Use the Select tool from the Edit Ribbon and select any areas that are not part of the actual 
construction feature you want to keep. In this example we are selecting any green areas not 
part of the dike and deleting them. Once selected either use the delete button on your 
keyboard, Delete button on the Ribbon or Right click on the polygon and delete.  

d. Alternative for cleaning up is open the attribute table for that layer and can select features 
by selecting rows. Code field has a -1 value which indicates those are cut areas which in the 
case of a dike and cut areas (Code -1) can be discarded and deleted.  

e. Save your edits on the Edit Ribbon 
5. Fill in attributes, subcuts and conversions: 

a. Right click on the cut\fill layer and choose open attribute table. 
b. Notice the Volume field which because we are in UTM coordinates was calculated in cubic 

meters.  
c. We want to add fields for unit conversions as well as can do sub-cut calculations 
d. Hit the Add button the attribute table menu 

 

e. At the bottom of the field list click add new field.  
f. Determine whatever units and steps you will need. In this example we will make 4 new 

fields. Give each a name and suggest using Data Type as Double for decimal places.  
i. CY – this is to convert from cubic meters to cubic yards 

ii. Acres – Could be any surface area units but need a surface area footprint. 
iii. Strip6inCY – In this example I will calculate a sub-cut of the dike area of 6 inches 

which is to take the top sod/vegetation off the surface before building up. Units will 
be in CY.  
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iv. TotalFill – This will be to take the original geometric volume calculated and add the 
subcut as we need to replace that volume lost for the total dike fill.  

 

v. Hit save on the top Fields Ribbon or just close the fields tab and save when 
prompted.  

g. Calculate the fields. 
i. For Acres use the Calculate Geometry Option. Right click on the Acres field and 

choose Calculate Geometry. Fill in Property as Area and Area Unit as Acres, Set the 
coordinate system and hit OK.  

 

ii. On the attribute table right click on the field you want to calculate and choose 
Calculate Field. Build your expression. To add a field to your expression double click 
it from the list. Type in other math functions.  

iii. CY = Volume * 1.30795 (The unit conversion from cubic meters to cubic yards) 
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iv. Strip6inCY = Acres * 1613 * 0.5 (1 acre 1ft deep is 1,613CY. We are sub-cutting half a 
foot so multiply by 0.5)  

v. TotalFill = CY + Subcut 

 

   

6. You now have an outline polygon of your cut\fill construction feature along with volume and sub-cut 
calculations ready for your scope of work.  
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Preparing for construction staking 

1. Assuming you used survey grade GPS to gather your site data as well as have survey grade GPS for 
construction staking you can take this design data to the field for construction staking to mark toe 
slopes and centerlines etc.  

2. Centerlines or Breaks: If you want the dike top or centerline, either export the dike outline and your 
dike contour line separately, OR prior to export edit the dike outline, use the Split tool to trace over 
the design contour line so the dike outline polygon is cut into segments divided by the contour lines. 
Edit from the Edit Ribbon. Select the dike outline and use the split tool. As long as you have 
Snapping turned on, your edit cursor should be able to snap to the line as you trace over it.  

 

3. Convert to shapefile: Many GPS units can not handle geodatabase feature classes but can use 
simple shapefiles.  

a. In the export process if any thing in that feature is selected it will only export the selected 
feature. If you want everything to export then make sure nothing is selected.  

b. To convert your feature class to a shapefile, right click on the layer and go to Data\Export 
Features.  

c. Choose your output location. If you want it to be a shapefile instead of a feature class then 
save to a folder NOT inside of a geodatabase.  

d. Give it an intuitive name with no spaces. 
e. Many GPS units can not reproject layers so they only work in the one defined coordinate 

system setup for that job. So any layers you wish to import to your GPS must be in the same 
coordinate system that is defined on your device. By default GIS will export the same 
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coordinate system as the original file. If you need to change this during the export then see 
the Environments tab during your export and change systems during the export.  

 

    

4. Copy your shapefiles to your GPS unit into the data file location for your unit.  
5. Trimble Access GPS software has the option to bring shapefiles into your job file. In the Job setup 

look for “Active Map” and from the Active Map list you can select available shapefiles. 
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6. You can then navigate on your unit to your drawn features to stake or check locations of the 
construction feature.  

 

 

Miscellaneous Tools & Features 

1. Wetland Mapping: Drawing wetlands or any other feature uses the same creation of a new feature 
class and edit function described above in creation of other layers in this tutorial.  

a. Use your topo map for the best wetland delineation tool or the depth grid. Soil maps may 
also help. 

b. Find the outlet point which is the lowest point around the basin and follow that contour 
around the basin. This is unless the wetland is controlled by a drainage structure or 
sand/gravel seam at a lower elevation or a dike is built at the outlet which will raise above 
the natural runout.  
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c. Many air photos should be used in wetland delineation. Depending on your purpose may 
map the highest extent seen in any recorded year or may be an average extent.  

d. Keep in mind wetlands are dynamic systems. They change depending on climate, 
precipitation, vegetation, landuse and drainage or manipulation. Mapping a wetland is a 
representation but may not reflect reality at any particular time.  

2. Snapping: During editing snapping can be handy. It will stick your cursor to any visible feature that is 
close which can make it easier to trace another object. However, at times you may want to draw 
independently and not snap to a nearby object.  

a. Snapping can be toggled on or off on the Edit menu with the snapping button. Additional 
options on the button drop down.  

 

b. Choosing which layers get snapped to can be controlled on the Contents pane snapping list. 

 

c. While drawing you can hold the Space Bar down at any time to temporarily disable snapping 
while the bar is held.  

3. Map Callout Text boxes 
a. ArcPro does not have the option for standard drawing/graphic features like text callout 

boxes in the map view like ArcGIS 10x did. This is unfortunate as it was a very common used 
feature for placing a quick reference note on your map when doing a GIS desktop review. 
Their new solution is suggesting to create a feature class point layer and setup labels which 
can be a bit cumbersome and time consuming when you just want to place a sticky note to 
reference something.  

b. The fastest and easiest option is to use the Layer Templates on the Insert Ribbon. See the 
dropdown list of premade templates and use the Text Notes at whatever scale is close to 
your project. We can change this scale later. This will create a new annotation layer in the 
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geodatabase that you have assigned as the default database for the project (From your 
project options settings). This is why you should have an individual database assigned at the 
beginning of each new project.  

 

c. You will see the Text Notes Layer in your Contents. 
d. Limitation to this option is it stays only at a specified scale by default so as you zoom in or 

out the text doesn’t change with it but could get very small or very large. You can 
individually resize which we will show below but for the default you must decide a scale that 
you will be working with your map the most. I find about 1:5000 fairly comfortable.  

e. To change the scale of the Text Notes Annotation. Go to Analysis Ribbon Tools button. In the 
Toolbox list Find Cartography Tools\Annotation\Update Annotation Scale. (If you use this a 
lot you may want to add it to your favorites list on the gallery tools.) Pick your layer and set 
the desired scale and run it.  

    

f. To create notes on the map just use the Editing function. Edit Ribbon, hit create. On the 
Create Feature Pane select Text Note Callout which will expand. Type your Text 
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g. Then Click on the map wherever you want the point of the callout to be, Drag around to 
wherever you want to callout box placed and click again to finish.  

 
h. If you want to modify the position or format the text, Select it with the Editor selection tool 

and Hit the Edit Annotation button on the top toolbar. You will then have handles to move 
or adjust the callout and at the bottom of the screen a box will have the font and size.  

 

 

 
4. Callout Text boxes in Layout view: 

a. Callout boxes in layout are available as drawing object similar to the older ArcGIS 10x 
versions. However, they give you the quick access text but need to do additional formatting 
to get the callout bubble.  

b. In Layout view go to the Insert Ribbon. Look for the Graphics and Text tools on the Ribbon.  
c. Click on a Text Box and place it on your layout map. 
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d. Right click on that text and choose properties or see the Format Ribbon at the top. From 
there under Text Symbol you can format the color font etc. Farther down the list is the 
option for Callout which you can choose callout options.  

 
e. Because this process is cumbersome to create a callout. I suggest creating 1 in your initial 

map template so it is available for all new maps created from that template. Have it on the 
side of your map in the layout so it is available. Then when you want to use it select and hit 
copy (or Ctrl+C) and Paste (Ctrl+V) to just copy the one premade and move and change the 
text. It will be much quicker that recreating from scratch each time.  

5. Measure Tools: 
a. Drawing shapes were often used in ArcMap for a quick measurement of acres without 

creating a new feature class/shapefile and calculating acres. This function is built into the 
measure tool for ArcPro. 

b. On the Map Ribbon find the Measure tool 
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c. Can choose length or area. On the tool pick your units and draw the measurement area on 
the map.  

 

d. Unlike the drawing tools in Arc Map, once done measuring the polygon does not remain on 
your map so used for quick measurement only. If you want polygons you need to create a 
Feature class.  

6. Print Map: Print options are found on the Share Ribbon and Print Map button 

 

7. Export to PDF or Image: This is also found on the Share Ribbon 
a. Hit the Export Layout (or Map depending on your view) button on the Ribbon 
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b. File type choose PFD or another image format and any other quality setting you need.  
c. Choose an output location. Note when you open the dialog box for the location it shows a 

Save button to close which is often confusing but this only save the name and location you 
chose but did not actually export it yet. Hit the Export button at the bottom to run the 
export.  

 

8. Label Decimal points 
a. Using the Double Field type allows for decimal points in your values but sometimes too 

many places and can clutter a map.  
b. Open the label properties for a layer (Right Click on the Layer) 
c. Use the VBScript Language or lookup alternative commands for other languages.  
d. In the Label Expression use the Round() command. Place the field you want to label and 

round in the parenthesis. After the field place a comma and the number of decimal places 
you want to round to such as Round([Acres],1) . Hit Apply to finish 
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Other Tutorial Resources: 

Other similar style tutorials are available at http://skralston.com/USFWS/ 

Please feel free to use and share these if they are useful to your projects. 

Subjects directly related to the workflow of this tutorial include: 

• Collecting GPS data with Trimble survey grade GPS 
• Creating and using a AGOL database and map to work between ArcPro and mobile devices 

• Flagging and staking construction with mobile GIS 
• Basic wetland restoration 101 techniques 

• Wetland flow calculations 

 

http://skralston.com/USFWS/

